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SUMMARY
These instructions do not purport to cover all details or variations in equipment, nor to provide for every 
possible contingency to be met in connection with installation, operation, or maintenence. Should further infor-
mation be desired or should particular problems arise which are not covered sufficiently for the purchaser’s 
purposes, the matter should be referred to the local Siemens Energy & Automation, Inc. sales office.
THE CONTENTS OF THIS INSTRUCTION MANUAL SHALL NOT BECOME PART OF OR MODIFY ANY PRIOR OR 
EXISTING AGREEMENT, COMMITMENT OR RELATIONSHIP. THE SALES CONTRACT CONTAINS ALL OBLIGA-
TIONS OF SIEMENS ENERGY & AUTOMATION, INC. THE WARRANTY CONTAINED IN THE CONTRACT 
BETWEEN THE PARTIES IS THE SOLE WARRANTY OF SIEMENS ENERGY & AUTOMATION, INC.
ACCESS, ISGS, Isolated Multi-Drop, S7-I/O, SBwin, SAMMS-LV, SAAMS-MV,SEAbus,SIEServe, Static Trip III, 
Wisdom, and WinPM are trademark, Sensitrip and Sentron are registered trademarks of Siemens Energy & 
Automation, Inc. SIEMENS is a registered trademark and Windows is a trademark of Microsoft Corporation. All 
other product names mentioned herein are used for identification purposes only and may be the trademarks or 
registered trademarks of their respective companies.

DANGER
Hazardous voltages and high-speed moving parts in electrical devices
communicating with WinPM .

Can cause death, serious injury or property damage.

See safety instruction contained herein.Restrict use to qualified personnel.

The use of unauthorized parts in the repair of the equipment 
or tampering by unqualified personnel will result in 
dangerous conditions that can cause death, serious injury or 
property damage. 

IMPORTANT

The information contained herein is general in nature and not 
intended for specific application purposes. It does not relieve 
the user of responsibility to use sound practices in appli-
cation, installation, operation, and maintenence of the 
equipment purchased. Siemens reserves the right to make 
changes at any time without notice or obligations. Should a 
conflict arise between the general information contained in 
this publication and the contents of drawings or supple-
mentary material or both, the latter shall take precedence.

QUALIFIED PERSONNEL

For the purposes of this manual and product labels,  "qualified 
personnel" is one who is familiar with the installation, 
construction, or operation of the equipment and the hazards 
involved. In addition, s/he has the following qualifications:

(a) is trained and authorized  to energize, de-energize, clear, 
ground, and tag circuits and equipment in accordance 
with established safety practices.

(b) is trained  in the proper care and use of protective gear 
equipment such as rubber gloves, hard hat, safety glasses 
or face shields, flash clothing, etc., in accordance with 
established safety procedures

(c) is trained  in rendering first aid.
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1 Introduction

1.1 Product Overview
The Panel-Tec DTU3005 is an intelligent, multiple-
function data transfer unit that enables communica-
tions between Siemens communicating power
meters, trip units, and protective relays, and PLCs or
Modbus networks. The device is designed for the
harsh industrial environment and is suited for use in
switchgear. The device is shown below in Figure 1.1.
The device is powered from an external power supply.
Three ports allow for connection to the Siemens
ACCESS devices and selected protective relays, a PLC
or a Modbus RTU or ASCII master system, and a
passthrough, which allows direct communications
with port 1 or port 2 from port 3. Status lights indicate
proper operation, and DIP switches allow access to
programming and diagnostic modes.

The DTU3005 device supports a wide variety of PLCs
and Siemens ACCESS devices. Appendix A lists the
PLCs and protocols supported by the DTU3005.
Appendix B lists the supported Siemens ACCESS
devices and protective relays.

Figure 1.1 Panel-Tec DTU3005 View Showing 3 Ports 
and Power Supply

1.2 Software Overview
The DTU3005 Editor software is a MS-DOS based pro-
gram for configuring the DTU3005 device. It provides
for uploading and downloading configurations via the
computer’s serial port. You can edit and save configu-
rations in project files on your computer’s hard drive.
Chapters 2 through 8 discuss installing and using the
editor software to configure your DTU3005 device.

1.3 Features

Device Features:

• Compact size (8" x 6" x 1")

• Port 1 and Port 3 Features

• Transfer data directly to one of 25 PLCs sup-
ported

• Baud rates up to 187,500 

• Addressable Modbus RTU slave capability

• (Port 3) Passthrough Port for connection to
WinPM

• Port 2 Features

• Twelve Siemens ACCESS devices supported

• Ten Siemens protective relays supported

Editor Software Features:

• MS-DOS based (also runs under Microsoft Win-
dows)

• Menu driven

• Mouse supported (but not required)

1.4 Applications
The following are possible hardware configurations
using the DTU3005 to connect to Siemens ACCESS
devices.
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1.4.1 PLC to SEAbus

The basic configuration is a PLC attached to port 1 of
the DTU3005, and the Siemens ACCESS devices
attached to port 2. This is shown below in Figure 1.2.
Port 3 can be configured as a passthrough to the SEA-
bus devices. This allows a personal computer running
Siemens WinPM™ or other supervisory software to
connect directly to the SEAbus devices at the same
time as the PLC. This is shown in Figure 1.3. An addi-
tional DTU3005 device can be attached to port 3. Up to
32 DTU3005 devices can be daisy chained together,
each connected to up to 32 Siemens devices. This is
shown in Figure 1.4.

Figure 1.2 PLC to SEAbus Application

Figure 1.3 PLC to SEAbus with Passthrough

Figure 1.4 Daisy Chained DTU3005 Units

1  2  3

DTU3005B

Up to 32
ACCESS Devices

Supported PLC

Acting as a
master transferring
data to PLC.

RS-485

1 2 3

DTU3005B

WinPM

Up to 32
ACCESS Devices

Supported PLC

Acting as a
master transferring
data to PLC.

RS-232

RS-485
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1.4.2 Modbus Master to SEAbus

The DTU3005 unit can be configured as a Modbus
(RTU) slave. In this configuration, a Modbus master
device (usually a SCADA system) is connected to port
1. The Modbus master uses the DTU3005 to monitor
and/or control Siemens ACCESS devices. A typical
Modbus application is shown below in Figure 1.5. The
passthrough port (port 3) can be used to connect to a
supervisory computer running WinPM software. It can
also be used to connect to a second, independent
Modbus Master device. This is shown in Figure 1.6.
Up to 32 DTU3005B units can be daisy chained using a
cable connected to port 1 of the three units. Each
DTU3005B device should have a different Modbus
device number. A daisy chained configuration is
shown in Figure 1.7.

Figure 1.5 Modbus Master to SEAbus

Figure 1.6 Two Independent Modbus Master Devices 
to SEAbus

1  2  3

DTU3005B

Up to 32
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Acting as a Modbus
(RTU) slave. Data
is requested by
supervisory software.

Supervisory Software
on Modbus Master

RS-485
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DTU3005B

Up to 32
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Acting as a Modbus
(RTU) slave. Data
is requested by
supervisory software.

Acting as a Modbus
(RTU) slave. Data
is requested by
supervisory software.

Supervisory Software
on Modbus Master

Independent Modbus Networks

Supervisory Software
on Modbus Master

RS-485
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Figure 1.7 Connection to Modbus Master using a 
Multidrop Cable

Multi-Drop Modbus Master to SEAbus

By using a Siemens Isolated Multi-Drop Converter,
you can connect your Modbus Master device to four
DTU3005 devices. Each DTU3005 can connect to up to
32 Siemens ACCESS devices, as well as be daisy
chained to up to 32 additional DTU3005 devices. An
example configuration is shown below in Figure 1.8.

Figure 1.8 Multi-Drop Configuration
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1.4.3 SEAbus Port Expander

The DTU3005 can be used as a SEAbus port expander
for ACCESS devices, allowing two personal comput-
ers running WinPM (or other supervisory software) to
communicate with up to 32 ACCESS devices. This
configuration is shown below in Figure 1.9.

Figure 1.9 SEAbus Port Expander
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2 Installing the Software
The DTU3005 Editor software can be installed from
the DOS prompt onto a PC running Microsoft® Win-
dows version 3.1, 95, or 98. The PC processor must be
less than 300 MHz (or have a utility program installed
to slow down the processor speed) for the Editor soft-
ware to work properly.

Note: The DTU3005 Editor software does not work in
a Windows NT environment.

If you are running Windows 3.1, double click the MS-
DOS Prompt icon in the Main window of Program
Manager. For Windows 95/98, select MS-DOS Prompt
from the Start menu. To install the Editor software,

insert the installation diskette into your computer and
follow the steps listed below. The computer screen,
showing the computer prompts and user responses,
is shown below.

1. Change the current drive at the DOS prompt to the
diskette drive. Type A:  (or B:  if that is your 3½"
diskette drive), and then press Enter.

2. At the A:\>  prompt, type install , and then
press Enter. The installation prompts you to select
which Editor software to install, as shown in the
example screen below. Type 1 and press Enter to
install the SEAbus Device Editor, or type 2 and
press Enter to install the VDEW Device Editor.

3. The program asks on which drive you want to
install the Editor software. For most computers,
this will be drive C. Type c  and press Enter.

4. The installation program then asks to which sub-
directory you want to install the DTU3005 Editor
software. This is where the program and configu-
ration files will be placed. The suggested direc-
tory name is DTU3005B. Type the directory name
at the prompt and press Enter.

5. You will now verify your drive and directory
choices. The installation program repeats your
entries and asks if the information is correct. Enter
Y if it is correct, and N if it is incorrect or you have
changed your mind. Then press Enter.

6. The installation program copies and unpacks the
editor program files onto your hard drive and
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returns you to the DOS prompt as shown in the
example screen below.

7. If you are running Windows, type exit  to close
the DOS window.
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3 Starting the Software
To start the DTU3005 Editor software, follow these
steps:

1. If you are running Windows 3.1, double click the
MS-DOS Prompt icon in the Main window of Pro-
gram Manager. For Windows 95/98, select MS-
DOS Prompt from the Start menu.

2. At the DOS prompt, which is usually C:\>  (or
C:\WINDOWS> if you are running a DOS prompt
from Windows) type CD \DTU3005B, where

DTU3005B is the directory where the Editor soft-
ware is installed. Press Enter.

3. At the new DOS prompt (which is C:\DTU3005B>
if you installed the program to the suggested
directory), type DTU3005 and then press Enter.

4. The DTU3005 Editor software starts. An informa-
tion screen appears as shown below.

5. Press Enter or Esc to close this information
screen and start using the program.

3.1 Menu Navigation
Navigation of the program menus and dialog boxes
can be performed with either the keyboard or a
mouse. The Editor software uses the standard menu
and dialog box user interface used by many other
DOS and Windows programs. The mouse can be used
to make menu selections, highlight and select items in
a dialog box, and perform commands by clicking on
dialog box buttons. Keyboard equivalents to mouse
actions are described in Table 3.1 below. Informational
messages are displayed on the bottom line of the
screen to give you help with keyboard navigation.

Note: To use a mouse in DOS, be sure the mouse
driver is loaded before starting the Editor
software. This is usually done automatically
from a command in the CONFIG.SYS or
AUTOEXEC.BAT startup files, or if you are
running the program from Windows, by
Windows itself. For information on how to

load a mouse driver, refer to the instruc-
tions included with your mouse.

Table 3.1 Keyboard Shortcuts for Menu Navigation

Key Description

Arrow keys Moves the highlight in the direction of 
the arrow.

Enter Performs the highlighted command.

Esc Cancels a function, closes the menu or 
dialog box, and returns you to the previ-
ous menu or dialog box.

Tab and 
Shift+Tab

The Tab key moves forward one item at 
a time within a dialog box. Shift+Tab 
moves backward one item at a time.

Letter keys The colored letter in each menu item 
indicates which key performs that com-
mand.

Spacebar Selects or deselects a highlighted item. 

Alt + Q Quits the program.
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3.2 Main Menu
The main menu is located on the top line of the
screen. In addition to the menu selections, the name
of the current project and the time of day is displayed
on the top line. There are five main menu selections.
They are

• ≡, or the Program Information menu. Selecting it
displays the program information screen.

• The Project menu enables you to create, load,
save, view and print project files. It also allows
you to switch to a DOS prompt or quit the pro-
gram. Its operation is described below in
Section 3.3 and  Section 3.4.

• The Edit menu enables you to configure projects
and is available only when a project is open.
Chapters 4, 5, and 6 describe the process of con-
figuring the different project types.

• The Transfer menu uploads and downloads
project files to the DTU3005 unit. These proce-
dures are described in Chapter 7.

• The Options menu allows you to change settings
on where the program finds its project files, and
which COM and LPT ports to use. Its operation is
described in Chapter 8.

3.3 Using the Project Menu
When you first start the DTU3005 Editor software, and
no project file is loaded, the following menu selections
are available in the Project menu (see example screen
below):

• Open, allows you to open any saved project file.

• New, allows you to create a new project file.

• Dos Shell, allows you to switch to MS-DOS with-
out closing the DTU3005 Editor software. To
return to the program, type exit  and then press
the Enter key at the DOS prompt.

• Quit, allows you to exit the DTU3005 Editor soft-
ware.

3.4 Starting a New Project
Projects contain the configuration information to be
downloaded to the DTU3005 device. To create a new
project:

1. Select the Project menu with the mouse, or use
the arrow keys to highlight Project and display the
Project menu:

2. Select New with the mouse, use keyboard short-
cut Ctrl + F3, or use the arrow keys to highlight
New and press Enter. The New Project dialog box
appears. 

Note: All menus and dialog box selections are
accessible from the keyboard or by using
the mouse. From this point the manual will
only say “select this” or “highlight this.”
Refer to  Section 3.1 for menu navigation
instructions and keyboard shortcuts.
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3. Type in a name for the project up to eight letters
and numbers in the Project Name: field and press
Enter. The Project Type: field will then be high-
lighted. Press the spacebar to display the project
types, which are:

• PLCs to Devices—allows a PLC to control
and/or monitor up to 32 supported Siemens
devices. See Chapter 4 for configuring this
project type.

• Modbus Master to Devices—allows a Mod-
bus speaking host system, personal com-
puter running SCADA software, or PLC to read
and write registers in up to 32 supported Sie-
mens devices. See Chapter 5 for configuring
this project type.

• SEAbus Port Expander—allows two Siemens
ACCESS supervisory computers to connect
up to 32 Siemens ACCESS devices. See
Chapter 6 for configuring this project type.
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4. To select a project type, highlight the type and
either press Enter or click the left mouse button.
Then highlight the Ok button on the dialog box
and either press Enter or click the left mouse but-
ton.

5. When the screen refreshes, the Project menu is
displayed with additional menu options now avail-
able. These options apply to the open project file
that is active (i.e., the project name appears in the
top line of the screen).

• Close—allows you to close a project file.
(More than one project file can be open at any
time.)

• View—allows you to view a project informa-
tion screen which shows the project file

name, project file type, the selections for each
of the DTU3005’s ports, and the number of
devices.

• Save—allows you to save the current project
file.

• Save As—allows you to save the project file
under a different file name.

• Switch To—allows you to switch between the
opened project files. (Multiple project files
can be open at the same time.)

• Print—allows you to print the project file’s
configuration information.

6. Select Save, or use the keyboard shortcut F10 to
save your new project. You are now ready to con-
figure your project.
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4 Creating Project Files—PLC to 
Devices

This chapter covers configuration of the DTU3005 for PLC
communications with Siemens devices. Once you have cre-
ated a PLC to Devices project (see Chapter 3), follow the
directions in this chapter to configure the project file. Then
see Chapter 7 for directions on downloading the project to
the DTU3005. See also Appendix D for wiring diagrams for
your particular PLC, as required.

4.1 Application Description
The PLC to Devices application allows a PLC to control and
monitor up to 32 SEAbus devices or Siemens protective
relays. In this application, the DTU3005B initiates all com-
munications with both the PLC and the Siemens devices.

The DTU3005B uses an internal transfer table to transfer
data to the PLC. The transfer table contains a block of
selected real-time data parameters obtained from a device.
The DTU3005B unit acts as a master to the PLC, and con-
tinuously transfers the table data to the selected block of
registers on the PLC. A delay option is provided for each
device’s table entry to prevent unnecessarily slowing down

the scan time of the PLC as well as to give some device
data transfers higher priority than others.

No ladder logic is required on the PLC to use the basic fea-
ture of this application, which allows a limited amount of
information to be transferred between the PLC and the
devices. Ladder logic programming is required to use the
command block function. The command block is used to
send commands to the devices, such as operating or
releasing relays, or resetting energy counters. See
Section 4.11 for information on configuring this feature on
the DTU3005B. The format of the command registers for
each device are described in Appendix E.

The DTU3005B can automatically update diagnostic infor-
mation in the PLC. It allows the PLC to determine when a
device is not communicating. See Section 4.10 for informa-
tion on enabling and configuring this feature. The format and
content of the diagnostic registers are described in detail in
Appendix F.

4.2 Configuring the Project File
Once you have created or opened the project file, select
Edit from the main menu to display the following menu
items:

• Port 1 (PLC)—allows you to select the model and con-
figure the communications settings for the PLC con-
nected to port 1.

• Port 2 (Devices)—allows you to configure communi-
cations settings for SEAbus devices or Siemens Pro-
tective relays connected to port 2.

• Port 3 (Passthrough)—allows you to select whether
port 3 is used as a passthrough to the devices or the
PLC.

• Diagnostics—allows you to indicate if you want the
DTU3005 to write communications diagnostic informa-
tion to the PLC.
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• Device Command Registers—allows you to indicate
which PLC registers will be used for device commands.

• Device Defaults—allows you to set the default data
registers for more than one device of a certain type,
e.g., set the defaults for all 4720 power meters or all
S7-I/O units. The data registers can still be customized
for each device, as required. See Section 4.7.2 for
more information.

• Device List—allows you to indicate which SEAbus
devices or Siemens protective relays are connected to
port 2 and which PLC registers they are communicat-
ing with.

If the Device Protocol for port 2 is set to VDEW (see
Section 4.4), then two additional menu items are available:
Global Command Registers and Device Text to Values
Table. See Section 4.8 and Section 4.9 for instructions on
using these menu items.

4.3 PLC Setup—Port 1
You must have a PLC to Devices project file open to config-
ure port 1 using the instructions in this section. Select Port
1 (PLC) from the Edit menu, and the Port 1 PLC Configura-
tion screen appears.
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To select the PLC connected to port 1, highlight PLC Pro-
tocol and press Enter. The PLC Protocols selection menu
appears:

PLC Protocol

Use the Down Arrow and Up Arrow keys to scroll through
the list of available PLC Protocols, since not all choices are
visible at one time. To select a protocol, highlight the selec-
tion and press Enter.

PLC Number

After you have selected your PLC, the PLC Number selec-
tion box is highlighted. The PLC Number is used to identify
which PLC the DTU is to communicate with (if the selected
type of PLC is addressable). The PLC Number is often
called a PLC Slave Address or Slave ID. 

Type in the PLC Number and press Enter.

2-Wire RS422 or RS485 Communications

After you have entered the PLC Number, the 2-Wire RS422
or RS485 Communications selection box is highlighted.
This box will only need to be checked if the communications
with your PLC is a 2-wire RS485 or RS422 interface. When
2-wire communications are being used, RTS must be
looped back to CTS on the DTU side of the cable. This can
be done on the RS232 side by looping pins 4 and 5 or on
the RS422/485 side by looping 16 to 18 and 17 to 19. See
Appendix D for wiring diagrams for your particular PLC,
and whether it uses a 2-wire connection.

To select the checkbox, click on it with the mouse or, with
the 2-Wire RS422 or RS485 Communications selection
highlighted, press the spacebar. An “X” will appear inside
the brackets when it is selected.

Press the Tab or Right Arrow key to move to the next field
without selecting this checkbox.

DTU Address

Some PLC protocols require each device on the PLC net-
work to be assigned a unique address or ID. The DTU
Address is the address assigned to the DTU on the PLC
network. Highlight this field and type in the address number
for the DTU3005B, then press Enter.

Communications Settings

The communications settings are automatically set to the
default values for each type of PLC when the PLC is first
selected. Before changing any of these settings, consult
your PLC manual for the correct settings. To move between
the communications settings, press the Tab or Enter keys.
To select a setting, use the Up or Down Arrow key to move
to the desired setting and press the spacebar to change
your selection.

RTS Control (Request to Send Control)

RTS Control selection is an option provided for modems or
for PLCs that require RTS to be active only while the DTU is
transmitting to the PLC. 

• If RTS/CTS is selected, the DTU will activate RTS and
wait until CTS is active before transmitting to the PLC. 

• If RTS Delay is selected, the DTU will activate RTS and
wait for the specified delay time to pass before trans-
mitting to the PLC. When RTS Delay is selected, the
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program displays an entry box for the RTS delay time.
Enter the time in milliseconds.

Response Time-Out

The Response Time-Out tells the DTU how long to wait
after transmitting a request to the PLC if no response has
been received from the PLC. After this amount of time

passes with no response being received, the DTU will
assume that no response is coming and will retry the
request. Enter the time in milliseconds.

Saving Port 1 Configuration Information

Once you have entered all the configuration information,
select Save to save the configuration to the project file.
Then select Ok or press the Esc key to close the configura-
tion screen. 

If you have changed the configuration and have not saved it
to the project file, you will be prompted to either save or dis-
card the changes. Select Revert to return to the last previ-
ously saved configuration without saving any changes. 

4.4 Device Setup—Port 2
One or more Siemens devices may be connected to port 2.
You must have a PLC to Devices project file open to config-
ure port 2 using the instructions in this section. 

Select Port 2 (Devices) from the Edit menu, and the Port 2
configuration screen appears.

Device Protocol

The Device Protocol indicates which Siemens devices can
be connected to port 2. This protocol is based on which
version of the DTU3005 Editor software was installed as
described in Chapter 2. 

• The SEAbus protocol (as shown in the example screen
above) indicates connection to Siemens ACCESS com-
municating trip units, relays, power meters and other
devices.

• The VDEW protocol indicates connection to Siemens
protective relays using the VDEW protocol. 

Note: Not all Siemens devices are supported. For a list
of supported devices, see Appendix B.

Other Configuration Information

The remaining configuration selections are the same as
those for port 1. Refer to Section 4.3 for instructions on
these fields.
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Saving Port 2 Configuration Information

Once you have entered all the configuration information,
select Save to save the configuration to the project file.
Then select Ok or press the Esc key to close the configura-
tion screen. 

If you have changed the configuration and have not saved it
to the project file, you will be prompted to either save or dis-
card the changes.

Select Revert to return to the last previously saved configu-
ration without saving any changes. 

4.5 Passthrough Setup—Port 3
Port 3 is for passthrough communications. It allows direct
communication with either the PLC on port 1 or the Sie-

mens SEAbus devices on port 2. (Passthrough communica-
tions to port 2 are not available for VDEW devices.) 

In passthrough mode, any messages received on port 3 of
the DTU are simply “passed through” to the PLC (port 1) or
devices (port 2). For example, passthrough communications
enables a PC running WinPM, or other supervisory software
connected to port 3 of the DTU3005, to communicate
directly with the SEAbus devices connected to port 2. 

You must have a PLC to Devices project file open to config-
ure port 3 using the instructions in this section. 

Select Port 3 (Passthrough) from the Edit menu, and the
Port 3 configuration screen appears.

The first option on the configuration screen allows you to
choose passthrough to port 1 or port 2. Select the appropri-
ate port with the mouse, or use the Up or Down Arrow
keys to highlight the selection and press Enter.

The remaining configuration selections except for Intermes-
sage Time-out are the same as those for port 1. Refer to
Section 4.3 for instructions on these fields.

Intermessage Time-Out

The DTU3005 uses the intermessage time-out to determine
when a complete message has been received on the
passthrough port. Once the first character of a message has
been received, if the amount of time specified by the inter-
message time-out passes with no additional characters
being received, the DTU3005 will consider the message to
be complete and process it.

To change the intermessage time-out, select Intermes-
sage Time-Out and type in the value in milliseconds, then
press Enter. 

Saving Port 3 Configuration Information

Once you have entered all the configuration information,
select Save to save the configuration to the project file.
Then select Ok or press the Esc key to close the configura-
tion screen. 

If you have changed the configuration and have not saved it
to the project file, you will be prompted to either save or dis-
card the changes. Select Revert to return to the last previ-
ously saved configuration without saving any changes. 
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4.6 Device List Setup
The Device List menu item enables you to indicate which
registers on the PLC will receive data from the devices. In
this screen, you will enter the device type and address for
each Siemens device connected to port 2. You will also indi-

cate to which registers on the PLC you want the DTU3005
to write device data.

Select Device List from the Edit menu to display the
device list screen:

This screen is divided into two parts:

• On the left side of the screen is a list of the devices con-
nected to port 2 (the list is initially empty). Up to 32
devices can be attached; however, only 17 of the
devices are visible on the screen at one time. To see all
the devices, click on the scroll bar with the mouse, or
use the Up and Down Arrow and Page Up and Page
Down keys. 

• The right side of the screen is used to configure the
data register information for the selected device, as
shown in the example screen on the next page. You
can add or delete devices, or change device configura-
tion by highlighting the Device Type on the left side of
the screen, then using the fields and buttons on the
right side of the screen. 

Adding a Device

To add a device to the device list:

1. Highlight the first line where the Device Type and
Address fields are blank—this should be the first avail-
able device number No field.

2. Press Enter or Tab to add a device. The cursor will
move to the Device Type field on the right side of the
screen. Press Enter, and the Device Types list dis-
plays:
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3. Select the device from the list by pressing Enter or the
spacebar. The highlight moves to the Address field,
and the PLC register fields now display as shown in the
example screen below.

4. With the Address field highlighted, enter the device’s
address. This number should be between 1 and 254,
and match the number programmed into the device

itself. Press the Tab key twice to go to the Real-Time
Data Registers field.

5. Highlight the File field and enter the file number. This
parameter is used only with Allen-Bradley PLCs to
specify the file number in the PLC that contains the reg-
ister values that are transferred to or from the device.
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6. Enter the beginning register number in the Real-Time
Data Registers field. Refer to Appendix A for valid
register numbers for your PLC application. The
DTU3005 Editor software supplies the last register
number after you enter the first. In the example above,
the 4700 Power Meter uses 41 registers for its data.
When you enter 1 for the first register, the last register
becomes 42. If you change the starting register to 10,
the last register will automatically change to 51.

Note: These registers indicate the exact location
in the PLC where the DTU3005 will store
the real-time data for this device.

7. Press Shift+Tab, or click the left mouse button to high-
light the File field and enter the file number. This
parameter is used only with Allen-Bradley PLCs to
specify the file number in the PLC that contains the reg-
ister values that are transferred to or from the device.

8. The device command registers are displayed below the
real-time data registers. They are configured from the
Device Command Registers menu selection on the
Edit menu. See Section 4.11 for information on setting
these registers and programming the PLC to perform
commands. Be sure that the register numbers are not
also used by the device. This can cause unexpected
operation of the device.

9. If you want to use a customized subset of the available
data registers, see Section 4.7.2 for instructions on
creating a default set of custom registers for all devices
of the same type. Type an “X” in the Use customized
real-time data ordering? field to begin the custom
data setup, or press Tab to go to the next field.

10. Enter the Real-Time Data Delay Time in its field. This
is the delay from the time that the DTU3005 receives
data from the device to the time the DTU3005 transfers
the data to the PLCs registers.

11. Select Save to save the device information to the
project file, and then select Ok or press Esc to exit the
device list configuration screen. If at any time you want
to return to the last saved version of the device list,
select Revert without saving any changes.

Removing a Device

To remove a device from the device list, highlight the device
on the left side of the screen and press Tab or Enter. Then
change the device type to Not In Use. 

Additional Options for Data Registers

The Device List screen has three additional options for
working with a device’s data registers:

• Select Set Reg to place the data registers into contigu-
ous register numbers and minimize the size to the data
register block. This option also sets the initial register
number to 1. 

• The Set All command performs the same function as
Set Reg, but allows you to set the initial register num-
ber. See Appendix A for information on acceptable
register number ranges for each PLC model. 

• Select Pack to minimize the size of the command reg-
ister block, removing registers for deleted devices.

Saving the Device List Configuration

Once you have entered the device information for all the
devices attached to port 2, select Save to save the device
information to the project file. Then select Ok or press Esc
to close the device list configuration screen.

If you have changed the device information and have not
saved it to the project file, you will be prompted to either
save or discard the changes.

Select Revert to return to the last previously saved configu-
ration without saving any changes. 

4.7 Configuring Custom Device 
Registers

You can configure which data items from the SEAbus or
VDEW devices are transferred from the DTU3005 device to
the PLC or Modbus master. In this way, the DTU3005 acts
as a data concentrator, in addition to converting the SEAbus
and VDEW protocol data. You can configure the custom
data items so that every device of the same type sends the
same data items (see Section 4.7.2), or have each device
send particular data items of interest (see Section 4.7.1).
SEAbus devices can be configured to send 16 words of
device data. VDEW devices can be configured to send from
1 to 64 words.

4.7.1 Configuring Custom Registers for a 
Single Device

To configure custom registers for a single device:

1. Select Device List from the Edit menu.

2. Highlight the device that you wish to configure and
press Enter.

3. Highlight the Use customized real-time data order-
ing? check box. Press the spacebar to place an “X” in
the check box. Then select Custom Data to display
the Customized Real-Time Data dialog box.
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4. Select a data register on the list and press Enter to see
a list of available real time data. These data items are
identical to the standard data items listed in Appendix

E. Not all data items are visible on the screen at one
time. Use the mouse and the scroll bar, or the Page Up
and Page Down keys to view all of the data items.
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5. Select the data word (16 bit data) from the list and
press Enter. Continue to set the other data words in
the same manner. Many data items consist of two
words (32 bit data). It is important that you configure
both words in order to transmit useful information to the
DTU3005’s registers.

6. Use these options as follows:

a. Select Set Defaults to copy the default custom
device registers to the list. See Section 4.7.2 for
instructions on setting custom device registers by
device type.

b. Select Clear All to delete all register names from
the list.

c. Select Set as Defaults to save the current cus-
tom register list as the default custom register list.
This will not change the custom registers of other
devices of the same type. See Section 4.7.1 for
instructions on setting custom device registers for
a single device.

4. Select Save to save your custom register list and then
Ok to exit this dialog box. Select Cancel to exit this
dialog box without making changes.

To conserve registers when using VDEW devices, you
should set all unused registers to “Not Used” and place
them at the end of the list. The DTU3005 will then only allo-
cate registers for those containing device data. (This does
not apply to SEAbus devices, for which the DTU3005 allo-
cates 16 registers regardless if they are used or not.)

4.7.2 Configuring Default Custom Device 
Registers by Device

If you are configuring custom device registers for more than
one device of a certain type, you may configure the default
custom registers from the Edit Menu Device Defaults
command. After configuring the default device registers, you
may use them for any or all devices, or further customize
individual registers for any of your devices. SEAbus devices
can have 16 custom registers. VDEW devices may have
between 1 and 64 custom registers.

To configure default custom registers for a particular device
type:

1. Select Device Defaults from the Edit menu. A list of
devices appears. If you have configured port 2 for SEA-
bus devices, only SEAbus devices will appear on the
menu. Likewise, if you have configured port 2 for VDEW
devices, only VDEW devices will appear on the menu.

2. Select the device you wish to configure. The default
custom register configuration menu appears. The first
time you select this command, the first 16 registers (64
for VDEW devices) from the device’s standard data reg-
ister list appear on the default real-time data list. Not all
of the entries are visible on the menu. Use the scroll bar
or the Page Up and Page Down keys to view all the
entries.
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3. Select a data item and press Enter to see a list of
device real time data that can be assigned to that data
word. Select Not Used if you do not want that data
word to be used. Not all of the entries are visible on the
menu. Use the scroll bar or the Page Up and Page

Down keys to view all the entries. Select Clear All to
set all data words to “Not Used.” Select Set to Base to
restore the data words to the first 16 registers (64 for
VDEW devices) from the device’s standard data regis-
ter list.

4. Select Save to save your configuration or Revert to
restore the last previously saved configuration for that
device. When you are finished configuring the default

data registers for that device, select Ok to close this
screen.
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To conserve registers when using VDEW devices, you
should set all unused registers to “Not Used” and place
them at the end of the list. The DTU3005 will then only allo-
cate registers for those containing device data. (This does
not apply to SEAbus devices, for which the DTU3005 allo-
cates 16 registers regardless if they are used or not.)

4.8 Device Text Setup (7SJ600 Only)
The Device Text to Values Table menu item is only available
for configuring the 7SJ600 relay. It is used to convert status

codes returned from select parameters in the 7SJ600 relay
(only) to values in a format useful to the system connected
to port 2 of the DTU3005. This affects the status readouts
from the device's binary inputs, signal and trip rated con-
tacts, and the LEDs.

To edit this table, select Device Text to Values Table from
the Edit menu. This selection is only available when the
device protocol for port 2 is set for “VDEW.”

Once open, 64 conversions can be defined.  To define a
conversion, enter the 7SJ600 relay status code in the Text #
column and enter the corresponding output value desired in
the Value column.
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The relevant status codes (Text #) are listed below.

Table 4.1 7SJ600 Relay Information 

For Requesting Status of the 7SJ600 Relay’s Three Binary Inputs

Text Number/Status Code 
(default value returned if 
not converted)

Description of Returned Binary 
Input Status Codes: I1 
indicates Input 1; I2,3 indicates 
Inputs 2 and 3

Suggested Value (Using This Conversion Table)

Value
Inputs I3 I2 I1

0 0 0 0 0

1342 I1,2 Inactive : I3 Active 4 0 1 0 0

1343 I1,3 Inactive : I2 Active 2 0 0 1 0

1344 I1 Inactive : I2,3 Active 6 0 1 1 0

1345 I2,3 Inactive : I1 Active 1 0 0 0 1

1346 I2 Inactive : I1,3 Active 5 0 1 0 1

1347 I3 Inactive : I1,2 Active 3 0 0 1 1

1348 I1,2,3 Active 7 0 1 1 1

For Requesting Status of the 7SJ600 Relay’s Two Trip Contacts and Two Signal Contacts

Text Number/Status Code 
(default value returned if 
not converted)

Description of Returned Trip 
and Signal Relay Status 
Codes: S1,2 indicates Signal 
Relays 1 and 2; T1,2 indicates 
Trip Relays 1 and 2

Suggested Value (Using This Conversion Table)

Value
Outputs S2 S1 T2 T1

Bits 15 . . . 4 3 2 1 0

1349 S1,2 T1,2 Open 0 0 0 0 0 0

1350 S1,2 T1 Open : T2 Closed 2 0 0 0 1 0

1351 S1,2 T2 open : T1 Closed 1 0 0 0 0 1

1352 S1,2 Open : T1,2 Closed 3 0 0 0 1 1

1353 S1 T1,2 Open : S2 Closed 8 0 1 0 0 0

1354 S1 T1 Open : S2 T2 Closed 10 0 1 0 1 0

1355 S1 T2 Open : S2 T1 Closed 9 0 1 0 0 1

1356 S1 Open : S2 T1,2 Closed 11 0 1 0 1 1

1357 S2 T1,2 Open : S1 Closed 4 0 0 1 0 0

1358 S2 T1 Open : S1 T2 Closed 6 0 0 1 1 0

1359 S2 T2 Open : S1 T1 Closed 5 0 0 1 0 1

1360 S2 Open : S1 T1,2 Closed 7 0 0 1 1 1

1361 T1,2 Open : S1,2 Closed 12 0 1 1 0 0

1362 T1 Open : S1,2 T2 Closed 14 0 1 1 1 0

1363 T2 Open : S1,2 T1 Closed 13 0 1 1 0 1

1364 S1,2 T1,2 Closed 15 0 1 1 1 1

For Requesting Status of the 7SJ600 Relay’s Four Programmable LEDs

Text Number/Status Code 
(default value returned if 
not converted)

Description of Returned LED 
Status Codes: L1,2 indicates 
LEDs 1 and 2

Suggested Value (Using This Conversion Table)

Value
Outputs L4 L3 L2 L1

Bits 15 . . . 4 3 2 1 0

1365 L1,2,3,4 Off 0 0 0 0 0 0

1366 L4 On : L1,2,3 Off 8 0 1 0 0 0

1367 L3 On : L1,2,4 Off 4 0 0 1 0 0

1368 L3,4 On : L1,2 Off 12 0 1 1 0 0

1369 L2 On : L1,3,4 Off 2 0 0 0 1 0

1370 L2,4 On : L1,3 Off 10 0 1 0 1 0

1371 L2,3 On : L1,4 Off 6 0 0 1 1 0
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Once you are finished entering data, select Save to save
your configuration, then select Ok to exit the dialog box.
Select Revert to bring back the previous settings.

4.9 Global Command Registers
This option allows you to specify global commands for all
the devices specified in the Device List. It is available only for
VDEW devices. 

The Global Command Registers consist of six registers.
These registers allow the PLC to transmit commands to all
the devices in the Device List. To send a command, all the
PLC needs to do is to place the command values into the
appropriate PLC registers, which the DTU3005 unit reads
and then processes.

4.10 Device Diagnostic Registers
This option programs the DTU3005 to send communica-
tions diagnostic information to a set of registers on the PLC.
The information can be used to troubleshoot problems with
the devices and the communications network.

The format and content of the diagnostic registers are
described in detail in Appendix F.

1. To configure the device diagnostic registers, select
Diagnostics from the Edit menu. The following screen
displays:

2. To enable the sending of diagnostic information to the
PLC, select the Do you want device diagnostics
information sent to PLC? checkbox with the mouse
or the spacebar. Then enter the starting register num-
ber in the PLC Registers: field. The register block is 6

bytes long. Be sure that the registers you specified are
not being used by other devices.

3. Press Shift+Tab, or click the left mouse button to high-
light the File field and enter the file number. This

1372 L2,3,4 On : L1 Off 14 0 1 1 1 0

1373 L1 On : L2,3,4 Off 1 0 0 0 0 1

1374 L1,4 On : L2,3 Off 9 0 1 0 0 1

1375 L1,3 On : L2,4 Off 5 0 0 1 0 1

1376 L1,3,4 On : L2 Off 13 0 1 1 0 1

1377 L1,2 On : L3,4 Off 3 0 0 0 1 1

1378 L1,2,4 On : L3 Off 11 0 1 0 1 1

1379 L1,2,3 On : L4 Off 7 0 0 1 1 1

1380 L1,2,3,4 On 15 0 1 1 1 1

Table 4.1 7SJ600 Relay Information  (Continued)
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parameter is used only with Allen-Bradley PLCs. It
specifies the file number in the PLC that contains the
register values that are transferred to or from the
device.

4. Select Save to save the information to the project file,
and then select Ok or press Esc to exit the device
diagnostic registers screen. If at any time you want to
return to the last saved version of the device diagnos-
tics registers, select Revert without saving any
changes.

4.11 Device Command Registers
The device command registers consist of two consecutive
registers for each device entered in the device list. These
registers allow the PLC to transmit commands to each of
the devices. To send a command, all the PLC needs to do is
to place the command values into the appropriate PLC reg-
isters, which the DTU3005B unit reads and then processes.

The first register contains the command, and the second
register contains the data associated with the command.
The format of the command registers for each device are
described in Appendix E. All the command registers are
placed in contiguous locations in the PLC’s registers and

are assigned by the DTU3005 to each device in the order
that they are listed in the device list.

To use the command registers for a particular device, the
PLC program must do the following, in order:

1. First, set the command word to 0 or -1 (FFFF hexadec-
imal).

2. Set the data word to the appropriate value.

3. Set the command word to the appropriate value.

4. After the command is set the PLC must wait for the
DTU3005B unit to change the command word to either
0 (to indicate successful processing of the command),
or -1 (to indicate an error).

To indicate the location of the command registers on the
PLC, follow these steps:

1. Select Device Command Registers from the Edit
menu. The Device Command Registers screen
appears:

2. Enter the starting register address in the PLC Regis-
ters field. The DTU3005 Editor software will determine
the proper number of registers for the number of
devices entered in the device list and indicate the final
register number. These registers must be different from
those used for device data and diagnostics. Refer to
Appendix A for a list of valid register numbers for your
PLC. Failure to use different register addresses will
cause communication errors, and may cause unex-
pected operation of the devices.

3. Press Shift+Tab, or click the left mouse button to high-
light the File field and enter the file number. This
parameter is used only with Allen-Bradley PLCs to
specify the file number in the PLC that contains the reg-
ister values that are transferred to or from the device.
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4. Enter the value for the Command Block Read Delay.
This is the delay between times that the DTU3005
reads the data from the PLC’s command registers. This
controls the frequency that the registers are read to
allow for critical PLC scan times.

5. Select Save to save the device information to the
project file, and then select Ok or press Esc to exit the
device command registers screen. If at any time you
want to return to the last saved version of the device
command registers, select Revert without saving any
changes.

4.12 Saving the Project File
Now you have completed configuring the DTU3005 for PLC
to device communications. Select Save from the Project
menu and press Enter, or press F10 to save the project file
to disk. The next step is to transfer the project to the
DTU3005 unit. This topic is covered in Chapter 7.
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5 Creating Project Files—Modbus 
Master to Devices

This chapter covers configuration of the DTU3005 for
Modbus master device communications with Siemens
devices. Once you have created a Modbus Master to
Devices project (see Chapter 3), follow the directions
in this chapter to configure the project file. Then see
Chapter 7 for directions on downloading the project to
the DTU3005.

5.1 Application Description
The Modbus Master to Devices application allows a
Modbus master (usually a SCADA system) to control

and monitor up to 32 SEAbus devices or Siemens pro-
tective relays. In this application, the DTU3005B acts
as a slave, and all communications with the Modbus
Master are initiated by the master device itself. The
DTU3005B converts Modbus requests received into
requests to access and control data on the Siemens
devices. Registers are assigned for each device in the
Holding Register range (40000 to 49999, where regis-
ter 40001 is the first to be used). The Modbus Master
accesses real-time data from the Siemens devices by
reading these registers, and sends commands by writ-
ing to these registers. Refer to Figure 5.1 for a matrix
representation of these registers.

Figure 5.1 Modbus Master to Devices Project—Data Registers Matrix
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5.2 Configuring the Project File
Once you have created or opened the project file,
select Edit from the main menu. When the Device Pro-
tocol for port 2 is set to SEAbus (see Section 5.4), the
following menu items appear:

• Port 1 (Modbus Master)—allows you to select the
protocol (RTU or ASCII) and configure the com-
munications settings for the Modbus Master
device connected to port 1.

• Port 2 (Devices)—allows you to configure commu-
nications settings for SEAbus devices or Siemens
Protective relays connected to port 2.

• Port 3 (Modbus/Passthrough)—allows you to
select whether port 3 is used as a passthrough to
the devices on port 2, or used for connection to a
second Modbus Master device.

• Diagnostics—allows you to indicate if you want
the DTU3005 to write communications diagnostic
information to the Modbus Master.

• Device Command Registers—allows you to indi-
cate which PLC registers will be used for device
commands.

• Device Defaults—allows you to set the default
data registers for more than one device of a cer-
tain type, e.g., set the defaults for all 4720 power
meters or all S7-I/O units. The data registers can
still be customized for each device, as required.
See Section 5.7.2 for more information.

• Device List—allows you to indicate which SEAbus
devices or Siemens protective relays are con-
nected to port 2 and which PLC registers they are
communicating with.

Note: If the Device Protocol for port 2 is set to
VDEW (see Section 5.4), then two addi-
tional menu items are available: Global
Command Registers and Device Text to
Values Table. See Section 5.8 and Section
for instructions on using these menu items.
In addition, the port 3 menu item is
changed to Port 3 (Modbus Master)
because the passthrough feature is not sup-
ported with VDEW devices. The instructions
in Section 5.3 are applicable to port 1 and to
port 3 for VDEW devices.
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5.3 Modbus Setup—Port 1
You must have a Modbus Master to Devices project
file open to configure port 1 using the instructions in
this section. Select Port 1 (Modbus Master) from the

Edit menu, and the Port 1 Modbus Master configura-
tion screen appears.

To select the protocol for the Modbus Master device
connected to port 1, highlight Modbus Protocol and

press Enter. The Modbus Master Protocol selection
menu appears:



5 Creating Project Files—Modbus Master to Devices

Siemens Energy & Automation, Inc.   31

Select either ASCII or RTU as your Modbus protocol,
then press the Tab key to highlight the Modbus ID
selection box. The Modbus ID is used to identify the
address of the DTU. Type in the Modbus ID number
and press Enter.

2-Wire RS422 or RS485 Communications

After you have entered the Modbus ID number, high-
light the 2-Wire RS422 or RS485 Communications
selection box. This box will only need to be checked if
the communications with your Modbus Master device
uses a 2-wire RS485 or RS422 interface (see
Figure 5.2). When 2-wire communications are being
used, RTS must be looped back to CTS on the DTU
side of the cable. This can be done on the RS232 side
by looping pins 4 and 5 or on the RS422/485 side by
looping 16 to 18 and 17 to 19. See Appendix D for wir-
ing diagrams for your particular PLC, and whether it
uses a 2-wire connection.

To select the checkbox, click on it with the mouse or,
with the 2-Wire RS422 or RS485 Communications
selection highlighted, press the spacebar. An “X” will
appear inside the brackets when it is selected.

Press the Tab or Right Arrow key to move to the next
field without selecting this checkbox.

Figure 5.2 RS-485 Connector (two-wire)

Communications Settings

Before changing any of these settings, consult your
device manual for the correct settings. To move
between the communications settings, press the Tab
or Enter keys. To select a setting, use the Up or Down
Arrow key to move to the desired setting and press the
spacebar to change your selection.

RTS Control (Request to Send Control)

RTS Control selection is an option provided for
modems or for Modbus Master devices that require
RTS to be active only while the DTU is transmitting to
the PLC. 

• If RTS/CTS is selected, the DTU will activate RTS
and wait until CTS is active before transmitting to
the PLC. 

• If RTS Delay is selected, the DTU will activate RTS
and wait for the specified delay time to pass
before transmitting to the PLC. When RTS Delay is
selected, the program displays an entry box for
the RTS delay time. Enter the time in milliseconds.

Response Time-Out

The Response Time-Out tells the DTU how long to
wait after transmitting a request to the PLC if no
response has been received from the PLC. After this
amount of time passes with no response being
received, the DTU will assume that no response is
coming and will retry the request. Enter the time in
milliseconds.

Saving Port 1 Configuration Information

Once you have entered all the configuration informa-
tion, select Save to save the configuration to the
project file. Then select Ok or press the Esc key to
close the configuration screen. 

If you have changed the configuration and have not
saved it to the project file, you will be prompted to
either save or discard the changes.

Select Revert to return to the last previously saved
configuration without saving any changes. 
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5.4 Device Setup—Port 2
One or more Siemens devices may be connected to
port 2. You must have a Modbus Master to Devices

project file open to configure port 2 using the instruc-
tions in this section. 

Select Port 2 (Devices) from the Edit menu, and the
Port 2 configuration screen appears.

Device Protocol

The Device Protocol indicates which Siemens devices
can be connected to port 2. This protocol is based on
which version of the DTU3005 Editor software was
installed as described in Chapter 2. 

• The SEAbus protocol (as shown in the example
screen above) indicates connection to Siemens
ACCESS communicating trip units, relays, power
meters and other devices.

• The VDEW protocol indicates connection to Sie-
mens protective relays using the VDEW protocol. 

Note: Not all Siemens devices are supported. For
a list of supported devices, see Appendix B.

Other Configuration Information

The remaining configuration selections are the same
as those for port 1. Refer to Section 5.3 for instructions
on these fields.

Saving Port 2 Configuration Information

Once you have entered all the configuration informa-
tion, select Save to save the configuration to the
project file. Then select Ok or press the Esc key to
close the configuration screen. 

If you have changed the configuration and have not
saved it to the project file, you will be prompted to
either save or discard the changes.

Select Revert to return to the last previously saved
configuration without saving any changes. 
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5.5 Modbus/Passthrough Setup—Port 
3

Port 3 can be used for passthrough communications
to your Siemens SEAbus devices or for connection to
a second Modbus Master device. Passthrough com-
munications enables a PC running WinPM, or other
supervisory software connected to port 3 of the
DTU3005 to communicate directly with the SEAbus
devices connected to port 2. In passthrough mode,

any messages received on port 3 of the DTU are sim-
ply “passed through” to the devices.

Passthrough communications are not available for
VDEW devices; see Section 5.3 for Port 3 (Modbus
Master) configuration of VDEW devices.

You must have a Modbus Master to Devices project
file open to configure port 3 using the instructions in
this section. Select Port 3 (Modbus/Passthrough) from
the Edit menu, and the Port 3 configuration screen
appears.

The first option on the configuration screen allows you
to choose connection to a second Modbus Master
device or passthrough to port 2. Select the appropriate
configuration with the mouse, or use the Up or Down
Arrow keys to highlight the selection and press the
spacebar.

Modbus Master

If you select Modbus Master, the screen appears as
shown above. Select the Modbus protocol by select-
ing the Modbus Protocol list box, highlighting either
ASCII or RTU, and pressing Enter. After you have
selected your protocol, press the Tab key to highlight
the Modbus ID selection box. The Modbus ID is used
to identify which Modbus Master device the DTU is to
communicate with. Type in the Modbus ID number
and press Enter.

The remaining configuration selections are for the
communications parameters and have the same
choices as those for port 1. Refer to  Section 5.3 for
instructions on these fields.
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Passthrough to Port 2 (SEAbus)

If you select Passthrough to Port 2 (SEAbus), the
screen appears as shown below.

2-Wire RS422 or RS485 Communications

After you have selected Passthrough to Port 2 (SEA-
bus), press Tab or select 2-Wire RS422 or RS485 Com-
munications. This box will only need to be checked if
the communications with your SEAbus devices use a
2-wire RS485 or RS422 interface. This is the usual
method of connecting SEAbus devices. When 2-wire
communications are being used, RTS must be looped
back to CTS on the DTU side of the cable. This can be
done on the RS232 side by looping pins 4 and 5 or on
the RS422/485 side by looping 16 to 18 and 17 to 19.
See Appendix D for wiring diagrams for your particu-
lar PLC, and whether it uses a 2-wire connection.

To select the checkbox, click on it with the mouse or,
with the 2-Wire RS422 or RS485 Communications
selection highlighted, press the spacebar. An “X” will
appear inside the brackets when it is selected.

Press the Tab or Right Arrow key to move to the next
field without selecting this checkbox.

Intermessage Time-Out

The DTU3005 uses the intermessage time-out to
determine when a complete message has been
received on the passthrough port. Once the first char-
acter of a message has been received, if the amount of
time specified by the intermessage time-out passes
with no additional characters being received, the
DTU3005 will consider the message to be complete
and process it.

To change the intermessage time-out, select Intermes-
sage Time-Out and enter the value in milliseconds,
then press Enter. 

Saving Port 3 Configuration Information

Once you have entered all the configuration informa-
tion, select Save to save the configuration to the
project file. Then select Ok or press the Esc key to
close the configuration screen. 

If you have changed the configuration and have not
saved it to the project file, you will be prompted to
either save or discard the changes.

Select Revert to return to the last previously saved
configuration without saving any changes. 

Other Configuration Information

The remaining configuration selections are the same
as those for port 1. Refer to Section 5.3 for instructions
on these fields.
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5.6 Device List Setup
The device list menu item enables you to indicate
which registers on the PLC will receive data from the
devices. In this menu, you will enter the device type
and address for each Siemens device connected to

port 2. You will also indicate to which registers on the
PLC you want the DTU3005 to write device data.

Select Device List from the Edit menu to display the
device list screen:

This screen is divided into two parts:

• On the left side of the screen is a list of the devices
connected to port 2 (the list is initially empty). Up
to 32 devices can be attached; however, only 17 of
the devices are visible on the screen at one time.
To see all the devices, click on the scroll bar with
the mouse, or use the Up and Down Arrow and
Page Up and Page Down keys. 

• The right side of the screen is used to configure
the data register information for the selected
device, as shown in the example screen on the
next page. You can add or delete devices, or
change device configuration by highlighting the
Device Type on the left side of the screen, then
using the fields and buttons on the right side of
the screen. 

Adding a Device

To add a device to the device list:

1. Highlight the first line where the Device Type and
Address fields are blank—this should be the first
available device number No field.

2. Press Enter or Tab to add a device. The cursor will
move to the Device Type field on the right side of

the screen. Press Enter, and the Device Types list
displays:
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3. Select the device from the list by pressing Enter
or the spacebar. The highlight moves to the
Address field, and the PLC register fields now dis-
play as shown in the example screen below.

4. With the Address field highlighted, enter the
device’s address. This number should be between
1 and 254, and match the number programmed
into the device itself. Press the Tab key twice to go
to the Real-Time Data Registers field.

5. Enter the beginning register number in the Real-
Time Data Registers field. Refer to Appendix A for
valid register numbers for your PLC application.
The DTU3005 Editor software supplies the last

register number after you enter the first. In the
example above, the 4700 Power Meter uses 41
registers for its data. When you enter 1 for the first
register, the last register becomes 42. If you
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change the starting register to 10, the last register
will automatically change to 51.

Note: The Modbus Master must read these regis-
ter numbers to be able to access the real-
time data for this device.

6. Press Shift+Tab, or click the left mouse button to
highlight the File field and enter the file number.
This parameter is used only with Allen-Bradley
PLCs to specify the file number in the PLC that
contains the register values that are transferred to
or from the device.

7. The device command registers are displayed
below the real-time data registers. They are con-
figured from the Device Command Registers
menu selection on the Edit menu. See
Section 5.11 for information on setting these reg-
isters and programming the PLC to perform com-
mands. Be sure that the register numbers are not
also used by the device. This can cause unex-
pected operation of the device.

8. If you want to use a customized subset of the
available data registers, see Section 5.7.2 for
instructions on creating a default set of custom
registers for all devices of the same type. Type an
“X” in the Use customized real-time data order-
ing? field to begin the custom data setup, or press
Tab to go to the next field.

9. Enter the Real-Time Data Delay Time in its field.
This is the delay from the time that the DTU3005
receives data from the device to the time the
DTU3005 transfers the data to the PLCs registers.

10. Select Save to save the device information to the
project file, and then select Ok or press Esc to exit
the device list configuration screen. If at any time
you want to return to the last saved version of the
device list, select Revert without saving any
changes.

Removing a Device

To remove a device from the device list, highlight the
device on the left side of the screen and press Tab or
Enter. Then change the device type to Not In Use. 

Additional Options for Data Registers

The Device List screen has three additional options for
working with a device’s data registers:

• Select Set Reg to place the data registers into
contiguous register numbers and minimize the
size to the data register block. This option also
sets the initial register number to 1. 

• The Set All command performs the same function
but allows you to set the initial register number.
See Appendix A for information on acceptable
register number ranges for each PLC model.

• Select Pack to minimize the size of the command
register block, removing registers for deleted
devices.

Saving the Device List Configuration

Once you have entered the device information for all
the devices attached to port 2, select Save to save the
device information to the project file. Then select Ok
or press Esc to close the device list configuration
screen.

If you have changed the device information and have
not saved it to the project file, you will be prompted to
either save or discard the changes.

Select Revert to return to the last previously saved
configuration without saving any changes.

5.7 Configuring Custom Device 
Registers

You can configure which data items from the SEAbus
or VDEW devices are transferred from the DTU3005
device to the PLC or Modbus master. In this way, the
DTU3005 acts as a data concentrator, in addition to
converting the SEAbus and VDEW protocol data. You
can configure the custom data items so that every
device of the same type sends the same data items
(see Section 5.7.2), or have each device send particu-
lar data items of interest (see Section 5.7.1). SEAbus
devices can be configured to send 16 words of device
data. VDEW devices can be configured to send from 1
to 64 words.

5.7.1 Configuring Custom Registers for a 
Single Device

To configure custom registers for a single device:

1. Select Device List from the Edit menu.

2. Highlight the device that you wish to configure
and press Enter.

3. Highlight the Use customized real-time data
ordering? check box. Press the spacebar to place
an “X” in the check box. Then select Custom Data
to display the Customized Real-Time Data dialog
box.
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4. Select a data register on the list and press Enter to
see a list of available real time data. The data
items are identical to the standard data items
listed in Appendix E. Not all data items are visible

on the screen at one time. Use the mouse and the
scroll bar, or the Page Up and Page Down keys to
view all of the data items.
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5. Select the data word (16 bit data) from the list and
press Enter. Continue to set the other data words
in the same manner. Many data items consist of
two words (32 bit data). It is important that you
configure both words in order to transmit useful
information to the DTU3005’s registers.

6. Use these options as follows:

a. Select Set Defaults to copy the default cus-
tom device registers to the list. See
Section 5.7.2 for instructions on setting cus-
tom device registers by device type.

b. Select Clear All to delete all register names from
the list.

c. Select Set as Defaults to save the current cus-
tom register list as the default custom register list.
This will not change the custom registers of other
devices of the same type. See Section 5.7.1 for
instructions on setting custom device registers for
a single device.

4. Select Save to save your custom register list and
then Ok to exit this dialog box. Select Cancel to
exit this dialog box without making changes.

To conserve registers when using VDEW devices, you
should set all unused registers to “Not Used” and
place them at the end of the list. The DTU3005 will
only allocate registers for those containing device
data. (This does not apply to SEAbus devices, for
which the DTU3005 allocates 16 registers regardless if
they are used or not.)

5.7.2 Configuring Default Custom Device 
Registers

If you are configuring custom device registers for
more than one device of a certain type, you may con-
figure the default custom registers from the Edit menu
Device Defaults command. After configuring the
default device registers, you may use them for any or
all devices, or further customize individual registers
for any of your devices. SEAbus devices can have 16
custom registers. VDEW devices may have between 1
and 64 custom registers.

To configure default custom registers for a particular
device type:

1. Select Device Defaults from the Edit menu. A list
of devices appears. If you have configured port 2
for SEAbus devices, only SEAbus devices will

2. Select the device you wish to configure. The
default custom register configuration menu
appears. The first time you select this command,
the first 16 registers (64 for VDEW devices) from
the device’s standard data register list appear on
the default real-time data list. Not all of the entries
are visible on the menu. Use the scroll bar or the
Page Up and Page Down keys to view all the
entries.
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3. Select a data item and press Enter to see a list of
device data items that can be assigned to that
data word. Select Not Used if you do not want that
data word to be used. Not all of the entries are vis-
ible on the menu. Use the scroll bar or the Page
Up and Page Down keys to view all the entries.

Select Clear All to set all data words to “Not
Used.” Select Set to Base to restore the data
words to the first 16 registers (64 for VDEW
devices) from the device’s standard data register
list.

4. Select Save to save your configuration or Revert
to restore the last previously saved configuration
for that device. When you are finished configuring

the default data registers for that device, select Ok
to close this screen.
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To conserve registers when using VDEW devices, you
should set all unused registers to “Not Used” and
place them at the end of the list. The DTU3005 will
only allocate registers for those containing device
data. (This does not apply to SEAbus devices, for
which the DTU3005 allocates 16 registers regardless if
they are used or not.)

5.8 Device Text Setup (7SJ600 Only)
The Device Text to Values Table menu item is only
available for configuring the 7SJ600 relay. It is used to

convert status codes returned from select parameters
in the 7SJ600 relay (only) to values in a format useful
to the system connected to port 2 of the DTU3005.
This affects the status readouts from the device's
binary inputs, signal and trip rated contacts, and the
LEDs.

To edit this table, select Device Text to Values Table
from the Edit menu. This selection is only available
when the device protocol for port 2 is set for “VDEW.”

Once open, 64 conversions can be defined.  To define
a conversion, enter the 7SJ600 relay status code in the
Text # column and enter the corresponding output
value desired in the Value column.
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The relevant status codes (Text #) are listed below.

Table 5.1 7SJ600 Relay Information 

For Requesting Status of the 7SJ600 Relay’s Three Binary Inputs

Text Number/Status Code 
(default value returned if 
not converted)

Description of Returned Binary 
Input Status Codes: I1 
indicates Input 1; I2,3 indicates 
Inputs 2 and 3

Suggested Value (Using This Conversion Table)

Value
Inputs I3 I2 I1

0 0 0 0 0

1342 I1,2 Inactive : I3 Active 4 0 1 0 0

1343 I1,3 Inactive : I2 Active 2 0 0 1 0

1344 I1 Inactive : I2,3 Active 6 0 1 1 0

1345 I2,3 Inactive : I1 Active 1 0 0 0 1

1346 I2 Inactive : I1,3 Active 5 0 1 0 1

1347 I3 Inactive : I1,2 Active 3 0 0 1 1

1348 I1,2,3 Active 7 0 1 1 1

For Requesting Status of the 7SJ600 Relay’s Two Trip Contacts and Two Signal Contacts

Text Number/Status Code 
(default value returned if 
not converted)

Description of Returned Trip 
and Signal Relay Status 
Codes: S1,2 indicates Signal 
Relays 1 and 2; T1,2 indicates 
Trip Relays 1 and 2

Suggested Value (Using This Conversion Table)

Value
Outputs S2 S1 T2 T1

Bits 15 . . . 4 3 2 1 0

1349 S1,2 T1,2 Open 0 0 0 0 0 0

1350 S1,2 T1 Open : T2 Closed 2 0 0 0 1 0

1351 S1,2 T2 open : T1 Closed 1 0 0 0 0 1

1352 S1,2 Open : T1,2 Closed 3 0 0 0 1 1

1353 S1 T1,2 Open : S2 Closed 8 0 1 0 0 0

1354 S1 T1 Open : S2 T2 Closed 10 0 1 0 1 0

1355 S1 T2 Open : S2 T1 Closed 9 0 1 0 0 1

1356 S1 Open : S2 T1,2 Closed 11 0 1 0 1 1

1357 S2 T1,2 Open : S1 Closed 4 0 0 1 0 0

1358 S2 T1 Open : S1 T2 Closed 6 0 0 1 1 0

1359 S2 T2 Open : S1 T1 Closed 5 0 0 1 0 1

1360 S2 Open : S1 T1,2 Closed 7 0 0 1 1 1

1361 T1,2 Open : S1,2 Closed 12 0 1 1 0 0

1362 T1 Open : S1,2 T2 Closed 14 0 1 1 1 0

1363 T2 Open : S1,2 T1 Closed 13 0 1 1 0 1

1364 S1,2 T1,2 Closed 15 0 1 1 1 1

For Requesting Status of the 7SJ600 Relay’s Four Programmable LEDs

Text Number/Status Code 
(default value returned if 
not converted)

Description of Returned LED 
Status Codes: L1,2 indicates 
LEDs 1 and 2

Suggested Value (Using This Conversion Table)

Value
Outputs L4 L3 L2 L1

Bits 15 . . . 4 3 2 1 0

1365 L1,2,3,4 Off 0 0 0 0 0 0

1366 L4 On : L1,2,3 Off 8 0 1 0 0 0

1367 L3 On : L1,2,4 Off 4 0 0 1 0 0

1368 L3,4 On : L1,2 Off 12 0 1 1 0 0

1369 L2 On : L1,3,4 Off 2 0 0 0 1 0

1370 L2,4 On : L1,3 Off 10 0 1 0 1 0

1371 L2,3 On : L1,4 Off 6 0 0 1 1 0
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Once you are finished entering data, select Save to
save your configuration, then select Ok to exit the dia-
log box. Select Revert to bring back the previous set-
tings.

5.9 Global Command Registers
This option allows you to specify global commands
for all the devices specified in the Device List. It is only
available for VDEW devices.

The Global Command Registers consist of six regis-
ters. These registers allow the PLC to transmit com-
mands to all the devices in the Device List. To send a
command, all the PLC needs to do is to place the com-
mand values into the appropriate PLC registers, which
the DTU3005 unit reads and then processes.

5.10 Device Diagnostic Registers
This option programs the DTU3005 to send communi-
cations diagnostic information to a set of registers
that can be read by the Modbus Master device. This
option allows the Modbus Master to collect diagnostic
information by reading the registers assigned here.
The information can be used to troubleshoot prob-
lems with the devices and the communications net-
work.

The format and content of the diagnostic registers are
described in detail in Appendix F.

1. To configure the device diagnostic registers,
select Diagnostics from the Edit menu. The fol-
lowing screen displays:

2. To enable the sending of diagnostic information to
the Modbus Master, select the Do you want to set
up device diagnostics registers? checkbox with
the mouse or the spacebar. Then enter the start-

ing register number in the Modbus Registers:
field. The register block is 6 bytes long. These are
written to the holding register area (40000 to
49999). Thus entering a 1 in this field represents

1372 L2,3,4 On : L1 Off 14 0 1 1 1 0

1373 L1 On : L2,3,4 Off 1 0 0 0 0 1

1374 L1,4 On : L2,3 Off 9 0 1 0 0 1

1375 L1,3 On : L2,4 Off 5 0 0 1 0 1

1376 L1,3,4 On : L2 Off 13 0 1 1 0 1

1377 L1,2 On : L3,4 Off 3 0 0 0 1 1

1378 L1,2,4 On : L3 Off 11 0 1 0 1 1

1379 L1,2,3 On : L4 Off 7 0 0 1 1 1

1380 L1,2,3,4 On 15 0 1 1 1 1

Table 5.1 7SJ600 Relay Information  (Continued)
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register 40001, etc. Be sure that the registers you
specified are not being used by other devices.

3. Select Save to save the information to the project
file, and then select Ok or press Esc to exit the
device diagnostic registers screen. If at any time
you want to return to the last saved version of the
device diagnostics registers, select Revert with-
out saving any changes.

5.11 Device Command Registers
The device command registers consist of two consec-
utive registers for each device entered in the device
list. These registers allow the Modbus Master device
to transmit commands to each of the devices by writ-

ing to the appropriate register. The first register con-
tains the command, and the second register contains
the data associated with the command. The format of
the command registers for each device are described
in Appendix E.

All the command registers are placed in contiguous
locations and are assigned to each device in the order
that they are listed in the device list. To indicate the
location of the command registers, follow these steps:

1. Select Device Command Registers from the Edit
menu. The Device Command Registers screen
appears:

2. Enter the starting register address in the Modbus
Registers field. The DTU3005 Editor software will
determine the proper number of registers for the
number of devices entered in the device list and
indicate the final register number. The registers
used are the holding registers (40000 to 49999).
Thus entering a register number of 1 will repre-
sent register 40001, etc. These registers must be
different from those used for device data and
diagnostics. Failure to use different register
addresses will cause communication errors, and
may cause unexpected operation of the devices.

3. Select Save to save the information to the project
file, and then select Ok or press Esc to exit the
device command registers screen. If at any time
you want to return to the last saved version of the
device diagnostics register, select Revert without
saving any changes.

5.12 Saving the Project File
Now you have completed configuring the DTU3005 for
Modbus Master to Devices communications. Select
Save from the Project menu and press Enter, or press
F10 to save the project file to disk. The next step is to
transfer the project to the DTU3005 unit. This topic is
covered in Chapter 7.
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6 Creating Project Files—SEAbus 
Port Expander

This chapter covers configuration of the DTU3005 as a
SEAbus port expander. Once you have created a SEA-
bus port expander project (see Chapter 3), follow the
directions in this chapter to configure the project file.
Then see Chapter 7 for directions on downloading the
project to the DTU3005.

When configured as a SEAbus port expander, the
DTU3005 allows two computers running supervisory
software, such as WinPM, to connect to the same Sie-
mens SEAbus devices. Up to 32 devices may be
attached to port 2 of the DTU3005 by an RS-485 con-
nection. This configuration is shown below in
Figure 6.1.

Figure 6.1 Dual Passthrough Application

Once you have created or opened the project file,
select Edit from the main menu and the following
menu items appear:

• Port 1 (Passthrough)—allows you to configure the
communications settings for the supervisory
computer connected to port 1.

• Port 2 (SEAbus Devices)—allows you to configure
communications settings for SEAbus devices con-
nected to port 2.

• Port 3 (Passthrough)—allows you to configure the
communications settings for the supervisory
computer connected to port 3.
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6.1 Passthrough Setup—Port 1
You must have a SEAbus Port Expander project file
open to configure port 1 using the instructions in this
section. Select Port 1 (Passthrough) from the Edit

menu, and the Port 1 (Passthrough) configuration
screen appears. 

2-Wire RS422 or RS485 Communications

The 2-Wire RS422 or RS485 Communications selec-
tion box will only need to be checked if the communi-

cations with your supervisory computer is a 2-wire
RS485 or RS422 interface. An example of this is if you
are using a RS-232/485 converter to extend the dis-
tance between your computer and the DTU3005.
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When 2-wire communications are being used, RTS
must be looped back to CTS on the DTU side of the
cable. This can be done on the RS232 side by looping
pins 4 and 5 or on the RS422/485 side by looping 16 to
18 and 17 to 19. See  Appendix D for wiring diagrams
for your particular PLC, and whether it uses a 2-wire
connection.

To select the checkbox, click on it with the mouse or,
with the 2-Wire RS422 or RS485 Communications
selection highlighted, press the spacebar. An “X” will
appear inside the brackets when it is selected.

Press the Tab or Right Arrow key to move to the next
field without selecting this checkbox.

Communications Settings

Before changing any of these settings, consult your
computer, modem, or RS-232/485 converter manual
for the correct settings. To move between the commu-
nications settings, press the Tab or Enter keys. To
select a setting, use the Up or Down Arrow key to
move to the desired setting and press the spacebar to
change your selection.

RTS Control (Request to Send Control)

RTS Control selection is an option provided for
modems or for RS-232/485 converters that require RTS
to be active only while the DTU is transmitting to the
computer. 

• If RTS/CTS is selected, the DTU will activate RTS
and wait until CTS is active before transmitting to
the computer attached to port 1. 

• If RTS Delay is selected, the DTU will activate RTS
and wait for the specified delay time to pass
before transmitting. When RTS Delay is selected,
the program displays an entry box for the RTS
delay time. Enter the time in milliseconds.

Intermessage Time-Out

The DTU3005 uses the intermessage time-out to
determine when a complete message has been
received on the passthrough port. Once the first char-
acter of a message has been received, if the amount of
time specified by the intermessage time-out passes
with no additional characters being received, the
DTU3005 will consider the message to be complete
and process it.

To change the intermessage time-out, select Intermes-
sage Time-Out and enter the value in milliseconds.
Then press the Enter key. 

Saving Port 1 Configuration Information

Once you have entered all the configuration informa-
tion, select Save to save the configuration to the
project file. Then select Ok or press the Esc key to
close the configuration screen. 

If you have changed the configuration and have not
saved it to the project file, you will be prompted to
either save or discard the changes.

Select Revert to return to the last previously saved
configuration without saving any changes. 
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6.2 SEAbus Device Setup—Port 2
One or more Siemens devices may be connected to
port 2. You must have a SEAbus Port Expander project

file open to configure port 2 using the instructions in
this section. 

Select Port 2 (SEAbus Devices) from the Edit menu,
and the Port 2 configuration screen appears.

Configuration Information

The configuration selections with the exception of
Response Time-Out are the same as those for port 1.
Refer to  Section 6.1 for instructions on configuring
these fields.

Response Time-Out

The Response Time-Out tells the DTU how long to wait
after transmitting a request to the PLC if no response
has been received from the PLC. After this amount of
time passes with no response being received, the DTU
will assume that no response is coming and will retry
the request. Enter the time in milliseconds.

Saving Port 2 Configuration Information

Once you have entered all the configuration informa-
tion, select Save to save the configuration to the
project file. Then select Ok or press the Esc key to
close the configuration screen. 

If you have changed the configuration and have not
saved it to the project file, you will be prompted to
either save or discard the changes.

Select Revert to return to the last previously saved
configuration without saving any changes. 

6.3 Passthrough Setup—Port 3
Select Port 3 (Passthrough) from the Edit menu, and
the Port 3 Passthrough configuration screen appears.
It is identical to the port 1 configuration screen, but
configures the communications settings for the super-
visory computer connected to port 3. The settings can
be different than those for port 1, depending on the
system. See Section 6.1 for directions for setting up
the passthrough port.

After configuring port 3, select Save to save the port 3
configuration to the project file, and then select Ok or
press Esc to exit the Port 3 Passthrough configuration
screen.
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7 Transferring Project Files
Once you have configured and saved your project file
for your particular application, you need to download
it to the DTU3005 unit. First verify which COM port on
your computer is used to upload and download
projects to the DTU3005 unit (see Chapter 8). Then,
select Transfer from the main menu and the following
selections are available:

• Download project to DTU3005—allows you to
transfer (download) any created project file from
your PC to the DTU3005.

• Upload project from DTU3005—allows you to
transfer (upload) the project file stored in the
DTU3005 to the PC. 

• Verify—allows you to verify a project file within
your computer against the current project file
stored in the DTU3005 unit.

• Check Application in DTU3005—allows you to
check what type of project file is loaded (PLC to
devices, Modbus Master to devices, or
Passthrough) and which protocols have been
loaded for each of the communication ports. It
also reports the revision level of the DTU3005
unit’s firmware.

Before using the Transfer commands, you must physi-
cally connect port 3 of the DTU3005B to your com-
puter using a null modem cable. Also be sure that
power is supplied to the DTU3005.
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.
Figure 7.1 Null Modem Cable connection

The null modem cable will cross pins 2 and 3 (RXD
and TXD). On the computer end of the cable, pins 7
and 8 (RTS and CTS) should be connected together.
Also pins 1, 4, and 6 (DCD, DTR and DSR) should be
connected together. The cable diagram is illustrated in
Figure 7.1. In addition, the DIP switches on the front of
the DTU3005B unit must be set to configuration mode
as described below. 

1. Power down the DTU3005B unit.

2. Set the DIP switches to configuration mode per
the DIP switch settings listed below in Table 7.1
and shown in Figure 7.1.

3. Restart the DTU3005B unit.

4. The status LED on the front of the DTU3005 unit
flashes green to indicate that the unit is in config-
uration mode.

Note: To return the device to normal opera-
tion, the DTU3005B unit must be pow-
ered off while the DIP switch settings
are reset, then the unit will be in normal
operation mode when it is powered up.

Figure 7.2 DIP Switch Settings for Normal Operation 
and Configuration Modes (Switch 4 is N/A)

7.1 Downloading Projects
Select Download project to DTU3005 from the Trans-
fer menu, and the following screen appears.

Select Ok and the DTU3005 Editor software transfers
the currently displayed project to the DTU3005 unit.

Table 7.1 Mode Switch Settings

Mode Switch 1 Switch 2 Switch 3 Status 
LED

Normal 
Operation

Off Off Off On 
steady

Configura-
tion

Off Off On Flashing 
Green

1

14

2

15

3

16

4

17

5

18

6

19

7

20

8

21

9

22

10

23

11

24

12

25

13

DTU3005B
Port 3

Personal Computer
RS-232 Port

2 TXD
3 RXD
7 Ground

1 DCD
2 RXD
3 TXD
4 DTR
5 Ground
6 DSR
7 CTS
8 RTS

DB-25 Male

DB-9 Female
5

9

4

8

3

7

2

6

1

Cable Type: 4 Conductor Round

Port 3


